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This preface describes:

m Apple software provided with AIX

m what’s in this guide and who should use it

m the available print and on-screen documentation

m special terms used in this guide

What the Network Server software offers

The software described in this guide contains IBM’s AIX (version 4.1)
operating system for use on the Apple Network Server. In addition, Apple
Computer, Inc. has supplied AppleTalk networking services to work with AIX,
and two applications that use a Macintosh interface for handling UNIX tasks.
These are the Disk Management Utility and CommandShell (which is used for
terminal emulation).

Who should use this guide

This guide is for system administrators and users of AIX on the Network
Server. It is meant for those who are familiar with basic UNIX system
administration techniques, but who are not familiar with AIXwindows, the
Common Desktop Environment™, InfoExplorer™, or the software that Apple
Computer, Inc. is including with AIX. 
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How to use this guide

This guide offers the basic information necessary to get up and running with
AIX on the Network Server. Detailed information on the use of the AIX
operating system and on system administration is available on screen. For a
discussion of the on-screen documentation, see “Documentation and On-
screen Information” next in this Preface.

This guide begins with an introductory chapter (Chapter 1) that introduces you
to the basic hardware and software configurations, user interfaces, and
standard AIX system management tools.

This is followed by a chapter on installation (Chapter 2), which describes
installation of the AIX Base Operating System (BOS) and additional software
from Apple Computer (the Disk Management Utility and CommandShell).

Chapters 3 through 6 discuss system startup and shutdown, the use of the
AIXwindows graphical interface and the Common Desktop Environment, the
use of the InfoExplorer on-screen documentation system, and basic AIX
system-administration tools.

Chapters 7 through 9 describe how to set up AppleTalk networking services,
how to manage file storage with the Disk Management Utility, and how to use
CommandShell for remote access.

Chapter 10 offers assistance with error messages and troubleshooting.

Documentation and on-screen information

This guide is the only printed documentation that comes with AIX and the
Apple software for the Network Server. However, it is assumed that you also
have Setting Up the Network Server available, which is included with the
Network Server.
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In addition, you can read or print IBM’s AIX documentation using the
InfoExplorer hypertext retrieval system, which is described in detail in Chapter
5. InfoExplorer makes available to you a wide range of user and system-
administration documentation, including the AIX 4.1 Getting Started guide,
upon which this guide is based.

For quick-start instructions on consulting IBM documents with InfoExplorer,
see “Using InfoExplorer to Learn InfoExplorer (Graphical Interface)” or
“Using InfoExplorer to Learn InfoExplorer (ASCII Interface),” in Chapter 5 of
this guide.

Users interested in learning more about AIX commands should consult the
information in the AIX Version 4.1 System User's Guide: Operating System
and Devices. Users in a networking environment who are interested in learning
more about AIX communications commands should consult the AIX Version
4.1 System User's Guide: Communications and Networks. For information on
ordering documentation published by IBM, call 800-879-2755. From outside
the United States, call 919-850-7500.

Terminology used in this guide

This section explains the terminology used in this guide to refer to modifier
keys and to various mouse and keyboard operations. 

Mo difier keys

If you are using a keyboard that doesn’t have an Alt key, use the Option key
wherever this guide refers to the Alt key. 

Mouse buttons

Some users will use a three-button mouse and some a one-button mouse. The
instructions in this guide are written for a three-button mouse, as are the IBM
documents that you can display with InfoExplorer (see “Documentation and
On-Screen Information,” earlier in this chapter). 
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If you are using a three-button mouse, the phrase the mouse button refers to
the first button (often called “the leftmost” button or “Mouse Button 1”) on
your three-button mouse. When this guide asks you to perform a mouse action,
such as clicking to select an object, use the first button unless the instructions
say otherwise.

If you are using a one-button mouse, wherever this guide instructs you to 
press the right mouse button, press the Right Arrow key on the keyboard. For
the equivalent of the middle button on a three-button mouse, press the Left
Arrow key.

Basic mouse and keyb oard op erations

In this guide, some terms represent a series of actions that you perform with
the mouse, keyboard, or both. For example, the word enter indicates that you
type a character (or a series of characters), then press the Return key. 

Here is a list of standard terms for mouse and keyboard operations and the
meaning of each term. 
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Term Action

Click Point to the object and then press and immediately release the 
mouse button.

Double-click Point to the object and then press and release the mouse button twice
in quick succession without moving the pointer.

Drag Point to an object on the screen, such as an icon that you want to
move. Press and hold down the mouse button while moving the mouse
until you have accomplished the desired task, such as moving the icon
to a new location, and then release the mouse button.

Choose Activate a command in a menu by pointing to the menu title and
dragging (usually downward) through the menu until the command you
want is highlighted. Then release the mouse button.

Point Move the mouse to position the pointer over an object on the screen.

Select Designate where the next action will take place. To select an object
such as an icon, point to the object and click the mouse button once.
When selected, the object appears highlighted. To select text, drag
across the text until the entire range of text that you want to select is
highlighted. 

Type Type a series of characters without pressing the Return key.

Press Press a single key or key combination without pressing the Return key
afterward, or point to an object and then press and hold down the
mouse button without moving the mouse.

Enter Type a series of characters and then press the Return key.

This guide refers to the Return key, although your keyboard might label it the
Enter key.
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This chapter introduces you to the AIX operating system for use on the
Network Server. It covers the following topics:

m hardware configuration

m software configuration

m user interfaces

m AppleTalk and Mac OS applications

m introduction to standard AIX system management tools

1 Introduction to the System



Introduction

For information on setting up the Network Server, consult Setting Up the
Network Server, which came with your Network Server, before you install AIX
or perform any other procedures discussed in this guide.

This guide assumes that you are administering the system either from a
console, that is, a monitor and keyboard directly connected to the Network
Server, or from a remote Macintosh computer.

If you are planning to work on a console that is directly connected to the
Network Server, consult Setting Up the Network Server for hardware
specifications. The console allows you to use the AIX graphical interface—
AIXwindows or the Common Desktop Environment (for information, see
Chapter 4 of this guide). If you are administering the system from a remotely
connected Macintosh computer running Macintosh System 7 or later, you can
use the Disk Management Utility and CommandShell (see Chapters 8 and 9 of
this guide).

You can also use a remotely connected X server, such as MacX on a
Macintosh computer.
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The mouse

The mouse most commonly used with AIX has three buttons. If you are using
a one-button mouse, you can use the arrow keys on the keyboard for the
middle and right mouse buttons, as follows:

m If you need to use the right mouse button, press the Right Arrow key.

m If you need to use the middle mouse button, press the Left Arrow key.
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System software components

Your Network Server uses three basic types of software: 

m application programs

m device drivers

m the AIX operating system

The following figure shows the relationship between the different software
programs and the hardware.

Application programs

Application programs allow you to perform specific user tasks, such as
running databases, file servers, or computer-aided design programs. 

Device drivers

Device drivers interact directly with computer hardware elements, such as
printers and monitors, and shield the application programs from the hardware
specifics of computers.
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Operating system

The operating system is a collection of programs that controls the running of
the computer and organizes the resources of a computer system. These
resources are the hardware components of the system, such as keyboards,
printers, monitors, and disk drives. The AIX operating system comes with
executable programs or utilities that maintain your files, send and receive
messages, provide miscellaneous information about your system, and so on.

An application program relies on the operating system to perform many
detailed tasks associated with the internal workings of the computer. The
operating system also accepts commands directly from you to manage files
and security.

Root-user processes and root permission

Root-user processes are programs that can be run only by a user with root
permission. A system administrator has root permission for all processes,
which allows him or her to

m read, write to (that is, change), or execute any program or file

m call any system function

m perform certain subsystem-control operations

If you are not allowed to run a command or to read or change a file, the system
displays a message saying you do not have the correct permissions or you are
not allowed to run that command. The system administrator may be the only
person who can log in as root on your system. However, the system
administrator can grant a user permission to use particular commands, giving
that user some control over processes.
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User interfaces

There are two types of user interfaces: the graphical user interfaces and the
command-line interface.

Graphical user interfaces

When a user interface has graphic objects, such as windows and menus, it is
called a graphical user interface (GUI). This section describes the following
graphical user interfaces: 

m AIXwindows

m The Common Desktop Environment (CDE)

AIX wind ows

AIXwindows lets you move windows, resize them, and copy text from window
to window. It allows applications to run separately and appear simultaneously
in different windows on your monitor. 

The aixterm terminal window, in the AIXwindows interface, emulates a
terminal. It contains a command-line prompt that allows you to run UNIX
commands. The AIXwindows interface is also used by many applications that
run on AIX. For a detailed description of the AIXwindows interface, see
Chapter 4.

The Common Desktop Environment

The Common Desktop Environment (CDE) allows you to use icons to access
networked devices and a wide variety of applications without having to be
aware of their locations, startup commands, or command-line options. It
allows you to exchange data across applications simply by dragging and
dropping objects. 
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The command-line interface

The command-line interface is a character-based interface. It is also known as
the shell. The screen displays a system prompt, and the commands you type
from the keyboard appear next to the prompt. 

The Disk Management Utility and CommandShell

In addition to AIX 4.1, the software used to run the Network Server also
includes the Disk Management Utility and CommandShell, which were
created by Apple for use with AIX on the Network Server. These applications
run on a remotely connected Macintosh computer. They connect to AIX
daemon processes to allow you to perform system administration tasks.

m The Disk Management Utility. This application allows you to manage all
aspects of disk storage. It uses a graphical user interface that offers various
views of the disk storage structure as well as methods of adding to, deleting
from, and modifying the disk storage structure. For more information, see
Chapter 8, “Managing File Storage With the Disk Management Utility.” 

m CommandShell. This application is a terminal emulator that runs multiple
windows on your screen so that you can run different AIX applications or
processes simultaneously. For more information, see Chapter 9, “Remote
Access With CommandShell.”

AppleTalk and AppleTalk services

You also have available to you AppleTalk and AppleTalk networking services,
created by Apple and engineered for use with AIX on the Network Server.
AppleTalk allows remotely connected Macintosh computers to access the AIX
server without using TCP/IP or other networking protocols. For more
information, see Chapters 7 and 8.

For information on standard network protocols, such as TCP/IP, see the
InfoExplorer article “Network Overview for System Management.”
InfoExplorer is described in Chapter 5. 
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Standard AIX system management tools

In addition to conventional command-line system administration, AIX
includes several system management tools and installation utilities, including
the Install Assistant, System Management Interface Tool (SMIT), and Visual
System Manager (VSM). 

The Installation Assistant application guides you through customization tasks.
The interface for Install Assistant provides step-by-step instructions for
completing each task. The application tells you why you would want to
perform certain tasks. If you are familiar with the tasks, you can skip the
instructions. 

SMIT is a menu-based tool that constructs and executes commands from the
options you choose. With SMIT you can 

m install, update, and maintain software

m configure devices

m configure disk storage units in volume groups and logical volumes

m make and extend file systems and paging space

m manage users and groups

m configure networks and communication applications

m configure printers

m identify system problems

VSM provides a graphical interface that lets you manage your system by dire c t ly
manipulating icons. You can use tools in VSM to perform many of the same
tasks as the SMIT ap p l i c ation. The VSM tool includes the fo l l owing ap p l i c at i o n s :

m Device Manager, which displays system objects and dialog boxes that
represent your system’s device configuration database. This allows you to
manage objects such as graphic adapters, ports, buses, and memory cards. 

m Print Manager, which allows you to perform basic SMIT tasks on printer
and print queues. 
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m Storage Manager, which lets you manage physical volumes, volume groups,
logical volumes, and file systems through manipulation of icons. 

m Users & Groups Manager, which lets you add users with simple templates.
You can also set passwords and the default interface for users. 

For information on using VSM, see Chapter 6, “Using System 
Administration Tools.”

The software for the Network Server also provides Mac OS utilities that
provide a Macintosh interface for logical volume management (the Disk
Management Utility, see Chapter 8 of this guide) and terminal emulation
(CommandShell, see Chapter 9 of this guide).

Where to go from here

If you have not yet installed AIX, proceed to Chapter 2. 

Note: If you plan to use the Redundant Array of Independent Disks (RAID)
software as your disk controller, install RAID before installing AIX. If you
install RAID after AIX has been installed, you will have to reinstall AIX. Back
up your disks carefully following the backup instructions in Chapter 2. 

If AIX has already been installed, proceed to Chapter 3.

For information on the AIXwindows interface, see Chapter 4.

For information on InfoExplorer, see Chapter 5.

For information on administering the system, particularly if you need
assistance with AppleTalk, the Disk Management Utility, or CommandShell,
see Chapters 7 through 9. 

For troubleshooting assistance and information on error messages, see 
Chapter 10.
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This chapter describes how to install the AIX Base Operating System (BOS).
This chapter also describes how to perform initial system configuration. 

The topics covered in this chapter include:

m getting ready for installation

m installing the BOS

m installing additional software such as extensions to the BOS provided by
Apple Computer

m setting up your system after you have completed the BOS installation progra m

m backing up your system

m installing the BOS from a system backup

m installing Mac OS utilities on a remote Mac OS client

2 Installing AIX on Your Network Server



Before you install

Before you begin the AIX installation process, do the following: 

m Set up your hardware and connect any peripheral devices such as an
additional hard disk drive.

m Locate your Installation CD.

m Obtain the Network Server key.

You must install the operating system on the local system (your 
Network Server).

For information about setting up your hardware, see Setting Up Your 
Network Server.

Installing the AIX Base Operating System

Follow these steps to install the AIX Base Operating System. 

1 Turn on your Network Server.

2 Insert the Installation CD into the drive. 

3 Turn the front key to the left (service) position.

4 Restart your Network Server with the CD in the drive.

To restart your system, press the reset button.

When your system starts, it will use the Installation CD as the boot disk.

A message appears asking you to define the system console.
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5 Press F1 and then Enter to use the local display as your console.

If you have a standard keyboard (without function keys), the top row of the
keypad serves as the function keys F1 through F4. If you have a standard
keyboard, press the Clear key on the keypad instead of F1. 

6 When prompted, select  a language for installation instructions.

For English, type 1 and press Enter.

The following message appears on your screen.

Welcome to the Base Operating System

Installation and Maintenance

Type the number of your choice and press Enter.

Choice is indicated by >>>.

> > > 1 Start install now with default settings

2 Change/show installation settings and install

3 Start maintenance mode for system recovery

8 8 HELP ?

9 9 PREVIOUS MENU

7 To begin installation, type 1 and press Enter.

To examine or modify installation settings, you can type 2 and press Enter.

The Installation and Settings screen appears.
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Installation and Settings

Either type 0 and press Enter to install with current

settings, or type the number of the setting you want to

change and press Enter.

1 . System Settings

Method of installation.............Preservation

Disk where you want to install...........hdisk0

2 . Primary Language Environment Settings (after 

i n s t a l l ) :

Cultural Convention......English (United States)

Language.................English (United States)

Keyboard.................English (United States)

Keyboard Type............Default

3 . Install Trusted Computing Base...............No

>>> 0  Install AIX with current settings listed above.

88 Help ?

99 Previous Menu

WARNING: Base Operating System installation will destroy

or impair recovery of some data on the destination disk

H D I S K 0 .

Use this dialog box to specify the following:

m the installation method

You can choose either the New and Complete Overwrite option or the
Preservation Install option. The New and Complete Overwrite option erases
all the information on your hard disk before installing the BOS. The
Preservation Install option keeps the user data in the root volume group
when it installs the BOS.
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m the destination disk 

m the language environment 

m the Trusted Computing Base (TCB) setting 

The Trusted Computing Base tries to ensure that the programs you run are
trusted programs. If you want to change the TCB setting, do so during
installation. This setting cannot be changed later.

8 When you have selected the appropriate settings, type 0 and press Enter to begin 
the installation.

The Installing Base Operating System dialog box ap p e a rs, wh i ch shows you the
progress of the installation and informs you when the installation is complete.

The installation process for the BOS takes about 20 to 30 minutes to complete.

9 Turn the front key back to the upright (unlocked) position before the installation completes.

When the BOS installation completes, the installation program restarts your
computer. The key must be in the upright position during this restart to boot
from the hard disk instead of the CD.

The BOS is now installed, and you can customize your installation. The next
section lists the customization tasks that you need to perform to set up your
system initially.

Installing additional software

Once you have installed the BOS, you need to install additional software, such
as the extensions to the AIX operating system provided by Apple Computer. 

To install additional software, use the Installation Assistant. After you have
installed the BOS, your computer restarts and automatically starts the
Installation Assistant application. The Install Assistant application guides you
through the installation process and provides step-by-step instructions for
completing each task. 
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To install additional software using the Installation Assistant:

1 Click Install Software Applications from the Installation Assistant Task List.

A menu appears with several items.

2 Click Install a Bundle of Software (Easy Install).

An Easy Install dialog box appears for additional installation information.

3 Specify the CD-ROM drive as the software source.

4 Select the All Licensed option as the bundle of software to install.

To select this bundle, you need to scroll to the bottom of the list of bundles and
click the All Licensed icon.

5 Click Install/Update.

The installation process begins. This process requires about 45 to 55 minutes
to complete.

6 Click Exit.

When you click Exit, you exit Easy Install and return to the task list for the
Installation Assistant.

7 Click Tasks Completed—Exit to AIX Login.

You must click the Tasks Completed option to quit this application to ensure
proper installation of the software.

Note: If you install from a terminal, a text-based Installation Assistant installs
additional software. To install the necessary software with the text-based
Installation Assistant, choose the custom install option and select the
a l l _ l i c e n s e d bundle to install.

Performing initial setup and administration tasks

After you have installed the BOS and additional software, the system can run
with its default settings: one user (root), the date and time that was set when
the system was manufactured, and other general settings. However, you
probably want to customize these settings and provide additional information,
such as a network configuration. 

16 Chapter 2 / Installing AIX on Your Network Server



The Installation Assistant provides step-by-step instructions for completing
each customization task. The application also tells you why you would want to
perform certain tasks. If you are familiar with the tasks, you can skip the
instructions and simply complete the tasks.

These are some of the tasks you may need to perform:

m Set the system date and time. 

m Set a root user account password and restrict access to system resources.
This step is vital to ensure the security of your computer. 

m Set up your TCP/IP network environment. 

For more information about configuring your TCP/IP environment, use
InfoExplorer to access the on-screen documentation. You can learn how to
use Info E x p l o rer in Chapter 5, “Using Info E x p l o rer to Retri eve Info rm at i o n .”

m Change the primary language environment.

m Create user accounts. 

m Configure your printer and add print queues for local printers and remote
print servers. See Chapter 7, “Setting Up AppleTalk and AppleTalk
Services,” to learn how to set up an AppleTalk printer and print queue.

m Import any existing volume groups. 

m Back up your system. See “Backing Up Your System,” later in this chapter,
for information about backing up your system.

After you’ve finished your customization tasks, you can use the Installation
Assistant to log in to the system. Use the Installation Assistant task item
“Tasks Completed—Exit to AIX Login” to quit the Installation Assistant and
ensure proper configuration.

You can access the Installation Assistant at any time by entering the command
i n s t a l l _ a s s i s t. 

For more information about any of these tasks, consult the on-screen
documentation with InfoExplorer.
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Setting your display resolution

After you’ve installed the operating system, you may want to customize your
display resolution. 

To set your screen preferences, you need to log in to AIX. For information
about logging in, see Chapter 3.

To set your screen preference: 

1 Start SMIT.

To start SMIT, enter s m i t on the command line. See Chapter 6 for more
information about using SMIT.

2 Choose Devices.

The Devices menu appears.

3 Choose Graphic Displays.

The Graphic Displays menu appears.

4 Choose Display Resolution and Refresh Rate. 

SMIT displays a list of available devices.

5 Click the device name. 

A dialog box appears with the attributes for the device.

6 Specify your resolution and refresh rate.

Use the List button to display the available resolutions and refresh rates.

For example, you can set your resolution and refresh rate to 1024x768@72Hz.

7 Click OK.

8 Restart your system.
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Backing up your system

After you have installed the BOS and performed your initial customization and
configuration, it is a good idea to create a system backup. You use a backup to
restore a corrupted file system and recover data. 

You can use the Installation Assistant to create a backup after your initial
installation. You can also use the System Management Interface Tool (SMIT)
to make a backup. SMIT uses the m k s y s b command to create a backup image
that you can store either on a tape or in a file. If you choose to back up to tape,
the backup program writes to the tape a boot image that you can use for
installation on other systems. 

For more information on using SMIT, see Chapter 6 and use InfoExplorer.

Configuring before the backup

C o n fi g u re your system befo re you cre ate a backup image if you want the image
to be identical and have the same users, passwords, network addresses, and so
on. However, if you plan to use the backup image to install the BOS on other
Network Servers, create the backup image before configuring the system. 

If you install the backup image on other systems, you might not want
passwords and network addresses copied. Using the same passwords on many
systems can create a security risk, and copying network addresses creates
duplicate addresses and can disrupt communications.

The BOS installation program automatically installs only the device drivers
required for the hardware configuration of the installed machine. Therefore, if
you are installing a system backup on other machines, you may need to install
a dditional device drive rs on the source system befo re making the backup image.

To install additional device support on the source system, use the Install
Additional Device Software SMIT menu item.
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Creating a backup

Follow the steps in this section to create a system backup. 

1 Log in as root.

2 Mount all file systems you want to back up. 

Refer to the mount command for details.

3 Free at least 8.8 MB of disk space in the / t m p directory or increase the size of your 
disk partition. 

The m k s y s b command requires this working space. To determine the free
space in the / t m p directory, use the d f command. If necessary, use SMIT or
the c h f s command to change the size of the file system.

4 Enter the following SMIT command:

smit mksysb

The Back Up the System screen appears.

5 Select how you want to store the backup.

Press F4 to list available tape devices. 

6 If you want to create map files, select the Create Map Files field.

Map files match the physical partitions on a drive to its logical partitions.

7 If you want to create a bootable backup, leave the default of yes. If you do not want a
bootable backup, press Tab to change the option to no.

8 Specify if you want to expand the / t m p directory if you have a bootable backup.

9 Specify the number of blocks to write in a single output, or leave the field blank to accept
the system default. 
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10 For a file backup, press Enter. For a tape backup, insert a tape and press Enter.

The Command Status screen appears. 

If you are creating a tape backup, the system may prompt you to insert 
another tape. 

11 When the backup completes, exit SMIT.

The backup is complete. If you created a bootable tape, it can start your
system if you are ever unable to start it from the hard disk.

Verifying a backup tape

You can use the procedures in this section to view the contents of a backup
tape. The contents list verifies most of the information on the tape, but it does
not verify that the tape can be used for installations. The only way to verify a
boot image on a tape is to try to start the system from it.

To verify a backup tape:

1 Enter the following SMIT command:

smit lsmksysb

The List Files in a System Image screen appears.

2 Type the number of blocks to read for your tape device, or leave the field blank to accept
the system default.

3 Either type the tape device name in the second field or accept the name provided.

4 Press the Enter key.

The Command Status screen appears listing the contents of the backup tape.
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Installing the BOS from a system backup

You can install the BOS from a tape backup image. 

Installing from a system backup reduces repetitive installation and
configuration tasks. 

When you install a backup image, the system determines if the target system
has enough disk space to create all the logical volumes. If so, the entire backup
is installed. Otherwise, the installation program stops the system and prompts
you to select more destination hard disks.

You can create a backup with SMIT using either the Backup the System menu
or the command mksysb -i TargetDevice. See “Backing Up Your System,”
earlier in this chapter, for more information.

To install from a backup:

1 Put the backup tape in the tape drive.

2 Shut down the system. Enter the command

shutdown -F

3 Turn the front key to the left (service) position.

4 Turn on your computer.

The computer starts from the backup tape. Follow the instructions in
“Installing the AIX Base Operating System” earlier in this chapter.

WARNING If you are using a backup to configure many systems, make
sure that the backup image was created before the system was
configured with network information and addresses and user accounts
and passwords. Duplicating this information causes network problems
and security risks. If you prefer, you can manually modify this
information on the new system after installation.
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Restoring a corrupted file system

Once you have created a backup, you might need to restore information that is
lost or damaged. 

To restore a file system from a tape backup:  

1 Put the backup tape in the tape drive.

2 Shut down the system. Enter the command

shutdown -F

3 Turn the front key to the left (service) position.

4 Turn on your computer.

The computer starts from the backup tape. 

A message appears asking you to define the system console.

5 Press F1 and then the Enter key to use the local display as your console.

You need an extended keyboard to identify your console unless you are
installing with a terminal connected to the modem port.

6 When prompted, select  a language for installation instructions.

For English, type 1 and press Enter.

The following message appears on your screen.

Welcome to the Base Operating System

Installation and Maintenance

Type the number of your choice and press Enter.

Choice is indicated by >>>.

1 Start install now with default settings

2 Change/show installation settings and install

> > > 3 Start maintenance mode for system recovery

8 8 HELP ?

9 9 PREVIOUS MENU
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7 Type 3 and press Enter.

A menu appears that lists options for system maintenance.

M a i n t e n a n c e

Type the number of your choice and press Enter.

Choice is indicated by >>>.

> > > 1 Access a Root Volume Group

2 Copy a System Dump to Removable Media

3 Access Advanced Maintenance Functions

4 Install from a System Backup

8 8 HELP ?

9 9 PREVIOUS MENU

8 Type 1 and press Enter.

The choice indicated by 1 lets you access a root volume group.

When you choose 1, the system warns you that you might overwrite existing
information and then lists the available volume groups.

9 Type the number of the volume group that you want to restore and press Enter.

A menu appears that lists the file systems on this volume group.

10 Type the number of the file system that you want to restore and press Enter.

Your system lists options for mounting the file system.

11 Select Mount File System and Start Shell.

Your system mounts the file system and provides a shell for you to enter UNIX
commands to examine the file system from the backup and re s t o re info rm at i o n .
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Installing Mac OS utilities on a Mac OS client

The software for the Network Server provides several Mac OS utilities to
perform such tasks as terminal emulation and remote administration of 
disk storage. 

You can install the Mac OS utilities on any computer running the Macintosh
Operating System.

To install the Mac OS utilities on a Mac OS client, follow these steps.

1 Quit all other applications.

The installation program adds extensions to your System Folder and does not
allow other programs to be running during the installation process.

2 Insert the Mac OS Utilities for the Network Server With AIX disk.

This is a 3.5-inch disk provided with the software for the Network Server.

3 Double-click the Installer icon.

A Welcome to AppleTalk Services dialog box appears.

4 Click Continue.

A dialog box appears that provides installation options.
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5 Choose your type of installation from the pop-up menu in the upper-left corner of the
dialog box.

You can choose one of the following options:

m Easy Install, which installs all of the Mac OS utilities and necessary
additional components.

m Custom Install, which lets you specify the components to install. Click 
the triangle to the left of “Everything” to view and select the components 
to install.

Note: All Mac OS utilities require the Network Server Passwd Tool, and
CommandShell requires the CommandShell VT102 component. 

m Custom Remove, which lets you remove Macintosh utility components
from your system.

6 Select the destination folder for the installation.

By default, the Mac OS utilities are installed in a folder named AppleTalk
S e rvices, and the extensions are placed in the System Folder in the boot system.

To change the disk for the installation, hold down the Option key. The Select
Folder option changes to Select System Disk. Use this option to specify the
installation disk.

7 Click Install.

The applications and components are installed on your system.

8 Once the installation is complete, restart your computer.

See Chapter 7, “Setting Up AppleTalk and AppleTalk Services,” to learn how
to configure and set up Mac OS utilities. 
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This chapter describes how to begin and end a work session. It covers the
following topics:

m logging in and out

m rebooting

m shutting down the system

3 System Startup, Logging In, 
Shutting Down, and Rebooting



Before logging in

This guide assumes that the following conditions have been met:

m You have the documentation for your computer and monitor hardware
available and that you are acquainted with the use of the hardware and any
necessary peripheral devices.

For detailed information on starting up and shutting down the Network
Server, see Setting Up the Network Server, which was packaged with the
Network Server.

m AIX has been properly installed on the server. If this is not the case, follow
the directions in Chapter 2.

m You have a user account and a password, or if you are administering the
system, you have root privileges and the root password.

Note: If you have problems booting AIX, consult the chapter “Starting Up
Your Server” in Setting Up the Network Server, where there is a description of
causes of Open Firmware problems and potential solutions. There is also a
description of error messages that might show up on the LCD during the
startup process. 

Logging in

To use the system, you must identify yourself to the system as an authorized
user by logging in with your login name. 

The appearance of the login prompt depends upon whether your system is set
to log in from the command-line interface or from the graphical interface. For
information on setting the system to log in to the graphical interface, see
“Setting Up Your System So That CDE Starts Automatically,” in Chapter 4.

Note: If your login prompt does not appear after you start up the system, see
“System Error Messages” in Chapter 10.
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The login prompt for the command-line interface is

l o g i n :

For more information on the graphical interface login window, see the next
section, “The Graphical Interface Login Window” later in this chapter.

1 Type your login name following the l o g i n : prompt, and press Return.

login: LoginName

If the p a s s w o r d : prompt does not appear, you have no password defined, and
you can begin working with the operating system. If the p a s s w o r d : prompt
does appear, continue with step 2.

2 Type your password and press Return. 

password: YourPassword

The screen does not display your password as you type it.

If the system displays an error message stating that your login is incorrect, log
in again and enter the correct login name and password. 

Remember that UNIX is case sensitive, that is, you must enter the login name
and password using the same lowercase or uppercase characters that were used
when the name and password were assigned. Thus, if your login name is
johnson, you will not be able to log in as Johnson.

Note: The root password is also the password for Open Firmware. 

After you have logged in and depending on how your system is set up, your
system will start up in a graphical interface (AIXwindows or Common
Desktop Environment) or in a command-line interface (the shell). 
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The graphical interface login window

The graphical interface login window contains an Options button that allows
you several options. For example, you can change to a command-line login 
as follows:

1 Click the Options button.

2 Choose Command Line Login.

A message appears that tells you to press any key to display the login prompt.

3 Press any key.

The l o g i n : prompt appears.

The Options menu also offers the following options:

m Language. Allows you to change the session language.

m Session. Allows you to choose Regular Desktop (the Common Desktop
Environment) or Failsafe session (an X windows environment).

m Reset Login Screen. Restarts the X server.

To delete what you have typed in the Login field, click the Start Over button. 

Shutting down

From the user’s viewpoint, stopping (shutting down) a system is simple, but
from the system’s viewpoint, the shutdown process involves a series of events
designed to preserve file integrity.

The safest and most thorough way to halt the operating system is to use the
s h u t d o w n command. When you designate the appropriate command options,
the s h u t d o w n command notifies users that the system is about to stop
operations, terminates all existing processes, unmounts file systems, and shuts
down the system.
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The steps that take place during a system shutdown depend on how the system
was customized. The shutdown described in this section may not appear
exactly the same on your system.

Note: You must have root privileges to shut down the system.

To shut down the system:

m At the prompt, enter 

s h u t d o w n

that is, type the command and then press Return.

By default, the system waits one minute before stopping the user processes
and the init process. You will see the following message:

shutdown completed... 

Rebooting the system

A system reboot recopies the operating system from disk to memory and starts
it without turning the system completely off. A reboot is also known as a
system reset. It reinitializes the operating system by repeating the initial
program load (IPL) operation. When the system is first turned on, the
operating system is usually booted automatically.

When the - r option is specified with the s h u t d o w n command, the system
reboots after it completes the shutdown.

m At the prompt, enter

shutdown -r

The system shuts down and reboots. 

You can also use the r e b o o t command. If no other users are logged into the
system, use the r e b o o t command to cause the system to recognize newly
installed software, to reset peripheral devices, or to perform routine
maintenance tasks, such as checking file systems. 

The s h u t d o w n command is used instead of the reboot command when the
system is running and other users are logged in.
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The steps that take place during a system reboot depend on how the system
was customized. The reboot process described in this section may not be
exactly the same on your system.

Note: You must have root privileges to reboot the system.

m At the prompt, enter

r e b o o t

The system reboots. 

Shutting down to single-user mode

In some cases, you may need to enter single-user mode (also referred to as
maintenance or standalone mode) in order to perform software maintenance
and diagnostics. To shut down the system to single-user mode, the current
directory must be the root directory, and you must have root privileges. 

1 Be sure that you are working in the root directory by entering

cd /

2 Enter

shutdown -m

The system shuts down to single-user mode. A system prompt appears, and
you can perform maintenance activities.

Shutting down quickly

Use the following procedure to stop the system quickly without notifying other
users. 

m At the prompt, enter

shutdown -F

The - F option instructs the s h u t d o w n command to bypass sending messages
to other users and to shut down the system as quickly as possible.
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This chapter describes the use of the AIXwindows interface, which allows you
to manage the aixterm terminal windows and any other X client windows on
your screen. It covers the following topics:

m starting and using the AIXwindows interface

m working with menus in the AIXwindows interface

m manipulating icons

m using the Common Desktop Environment

4 Using AIXwindows and 
the Common Desktop Environment



Introduction to AIXwindows

AIXwindows runs a terminal emulator (a i x t e r m) in a terminal window. The
AIXwindows interface allows you to

m run several programs simultaneously on a single screen

m create multiple windows to meet your specific needs

m cut and paste text between windows

m control various terminal functions

Note: Many of the commands described in this chapter use the Alt key. If your
keyboard does not have an Alt key, use the Option key in its place.

Starting AIXwindows from the command line

When you log in to your system, you start in either the command-line
interface, AIXwindows, or Common Desktop Environment, depending on how
your system is set up. If you start up in the command-line interface, start
AIXwindows by entering the following command:

x i n i t
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Elements of the AIXwindows interface

When AIXwindows starts, an aixterm terminal window appears that contains
the elements shown in the following illustration: 

The elements of the window are described here:

m Client area. The input and output of the program take place here.

m R e s i ze handles. Point to a re s i ze handle and drag it to ch a n ge the window size.

m Title bar. The title of the program or other specified info rm ation is displaye d.

m Window menu button. Click the window menu button to display the
Window Manager menu.

m M i n i m i ze button. Click the minimize button to conve rt the window to an icon.

m Maximize button. Click the maximize button to expand the window to its
maximum size (often the full screen), or to contract it to its previous size.
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Mouse pointer shapes

When AIXwindows starts, an X-shaped mouse pointer appears at the center of
the screen. The pointer shape changes according to its location. For example,
when the pointer is directly over the root window (the background behind all
windows), the pointer has an X shape. When the mouse points inside a
terminal window, the pointer changes to an I-beam shape. A description and
illustration of pointer shapes follows. 

Arrow pointers

An arrow pointing to the upper-left corner is the general-purpose pointer used
in most window areas for selecting and activating single objects.

An arrow pointing to the upper-right corner indicates a pending menu action.
This shape indicates that a menu is popped up or pulled down and that you
must choose a menu item or release the menu. 

Caution pointer

The caution pointer indicates that some action is expected in another area
before you can give input to the current area. All mouse and keyboard actions
are ignored in the area where the caution pointer appears.
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Four-directional arrow pointer

The four-directional arrow pointer indicates that a move operation is in
progress. During a move operation, the object, or an outline of the object,
tracks the location of the pointer.

Hourglass pointer

The hourglass pointer indicates that an action is in progress in the area. While
the hourglass pointer is active, all mouse and keyboard actions are ignored in
the area. The hourglass pointer and the watch pointer (shown later in this
section) mean the same.

I-beam pointer

The I-beam pointer indicates where you can perform actions on the text and
changes the location of the text-insertion cursor. 
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Resize pointer

The resize pointer indicates that the pointer is at one of the resize bars of the
window. The direction of the arrow indicates the direction in which you move
the pointer to increase the size of the window. The horizontal and vertical
pointers indicate that the window is changed in either the horizontal or vertical
direction. The diagonal pointers indicate that the window is changed in both
the horizontal and vertical directions simultaneously.

Sighting pointer

The sighting pointer is used to make precise position selections. For example,
in a drawing program, it may be used to indicate a pixel to fill or the
connecting points of lines.

Watch pointer

See “Hourglass Pointer,” earlier in this section.

X pointer

The X pointer indicates that the pointer is outside any application area. 
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Selecting a window

To activate a window so that it can receive input: 

m Point to any part of the window and click the mouse button. 

The window frame changes color. 

The Window Manager menu

The Window Manager menu (which is often referred to as the window menu)
allows you to perform the most important window-manipulation tasks. 

To display the Window Manager menu:

m Click the Window Manager menu button (to the left of the window’s title bar) with the
mouse button. You may also press the Shift-Esc or the Alt (or Option)-Spacebar key
combination while pressing the left mouse button.

The Window Manager menu contains the following items:

m Restore. Restores a window from an icon or to its previous size.

m Move. Changes the location of the window (see “Moving a Window” later
in this chapter).

m Size. Changes the size of a window (see “Resizing a Window” later in 
this chapter).

m Minimize. Turns the window into an icon.

m Maximize. Enlarges the window to cover the entire root window.

m Lower. Sends a window to the back or bottom of the window stack, the
position closest to the root window. If the window is active, it remains
active until another window is made active.

m Close. Immediately stops the process running in the window and closes 
the window. 

To cancel the Window Manager menu:

m Press Esc (the Escape key).
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Choosing a menu item

To choose a menu item, follow these steps:

1 Display the menu.

2 Hold down the mouse button and drag the pointer down the menu until the item you wish
to choose is highlighted. 

3 Release the mouse button.

You can also press the accelerator keys (shown to the right of the menu items)
without displaying the menu, or you can press the underlined mnemonic
characters with the menu displayed. 

Displaying the root menu

The root menu offe rs seve ral options for controlling your AIXwindows interfa c e.

To display the root menu:

1 Point to the root window (the background behind all other windows).

2 Press and hold the right mouse button (or the Right Arrow key).

You can customize the root menu. See the article “Managing AIXwindows
Menus, Mouse Buttons, and Keyboard Bindings” in InfoExplorer (which is
d e s c ribed in Chapter 5). By default, the root menu contains the fo l l owing items:

m New Window. Opens a new aixterm window.

m Clients. Opens a submenu that allows you to display a new clock, open the
System Management Interface Tool (SMIT), or lock the screen.

m Custom. Opens the Customizing Tool interface for customizing ap p l i c at i o n s .

m Refresh. Refreshes the screen.

m Pack Icons. Arranges all icons on the screen in one or more neat rows.

m Restart. Restarts the Window Manager.

m End Session. Quits AIXwindows.
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Moving a window

You can move windows using the mouse or the Move item in the Window
Manager menu. 

m Point in the window’s title bar, and drag the mouse pointer in the appropriate direction. 

If you prefer, you may use the following procedure:

1 Choose Move from the Window Manager menu.

2 Point in the window and drag the window to its new position.

3 When the window reaches the new location, press the Return key or click any mouse
button.

Note: To cancel the move, press Esc before you release the mouse button.

Opening a new terminal window

To open a new terminal window: 

m Choose the New Window menu item from the root menu.

If you prefer, you may use the following procedure:

m At the prompt in a window, enter

aixterm& 

A new window is displayed, usually 80 characters wide and 25 lines long.
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Bringing a window forward or moving it back

You can use any of three methods for moving a window forward and backward
(in other words, on top of or beneath other windows). 

m Click in any visible portion of a window frame. 

If the window is behind other windows, it becomes the active window and
moves to the front. 

m Display the root menu and choose Shuffle Up to move the window at the bottom 
of the window stack to the top, or choose Shuffle Down to move the window at the 
top of the window stack to the bottom.

m Display the Window Manager menu and choose Lower (or press the L key), or you can
press the Alt (or Option)-F3 key combination. 

The frontmost window moves behind the other windows.

Note: If you use the Lower menu item to move the active window behind 
the other windows, the active window stays active until another window is
made active.

Resizing a window

You can change the size of a window using the mouse, the Window Manager
menu, or a combination of the mouse and keyboard. 

1 Point to an edge or corner of the window frame.

2 Drag the edge or corner to increase or decrease the size of the window. 

3 When the window reaches the desired size, release the mouse button.
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If you prefer, you may use the following procedure:

1 Display the Window Manager menu and choose Size (or press the I key), or you can
press the Alt (or Option)-F8 key combination. 

A counter appears in the center of the screen, showing the size in characters of
the window as it changes; the outline of a rectangle surrounds the window. Use
the mouse to expand or shrink the window.

2 When the window reaches the desired size, press the Return key, or click any mouse
button.

Note: To cancel the resizing, press Esc before you release the mouse button.

Maximizing a window and restoring it to its previous size

You can maximize a window by expanding it to the full size of the screen. 

m Click the maximize button (at the extreme right of the title bar) with the mouse button. 

If the window is already maximized, this action returns the window to its
previous size.

If you prefer, you may use the following procedure:

m Display the Window Manager menu and choose Maximize (or press the X key) , or you
can press the Alt (or Option)-F10 key combination.

To return a window to its previous size:

m Display the Window Manager menu and choose Restore (or press the R key), or you can
press the Alt (or Option)-F5 key combination.
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Closing a window

When you quit an application that is running within its own window, the
window usually closes. However, if you must close a window yourself, do 
the following: 

m Double-click the window menu button.

If you prefer, you may use the following procedure:

m Display the Window Manager menu and choose the Close menu item (or press the S
key), or you can press the Alt (or Option)-F4 key combination.

Changing windows into icons and restoring windows from icons

To change a window into an icon, do the following: 

m Click the minimize button (on the right side of the title bar, but to the left of the 
maximize button).

If you prefer, you may use the following procedure:

m Display the Window Manager menu and choose the Minimize menu item (or press the N
key) , or you can press the Alt (or Option)-F9 key combination.

In either case, the window disappears and its icon appears.

To restore a window from an icon:

m Double-click the icon or, with the icon selected, press the Alt (or Option)-F5 key
combination.
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Getting help in a window

There are various tools available to help you when you need more information
about commands or about the operating system. 

m The InfoExplorer program, an on-screen hypertext information base, allows
you to display and print items from IBM’s on-screen documentation (see
Chapter 5).

m The h e l p command displays information about basic commands.

m The man command displays information about all commands, subroutines,
and files. 

Using the help Command

The h e l p command presents a one-page display of information for new users.
Use this command as follows:

m At the prompt in a terminal window, enter

h e l p

The system displays information as shown in in the following figure.
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Exiting and logging out from AIXwindows

Before exiting AIXwindows, stop any programs that are running in terminal
windows. This avoids loss of data.

When you exit a program, the command-line prompt returns to the terminal
window. However, if you started the program automatically or from a menu,
exiting removes the terminal window. 

Choosing Close from the Window Manager menu immediately stops any
program running in the window. Interrupting a program like this may cause it
to lose data. However, you can close the clock or an idle terminal window (one
showing a command-line prompt) with no ill effect. 

To exit AIXwindows: 

m Select End Session in the root menu.

Copying text between windows 

When you have text in a terminal window, the a i x t e r m program allows you
to select text and copy it within the same window or to other windows if the
application that is running in the window supports this feature. 

To copy text from one window into another window:

1 Have the window you want to copy from and the window you plan to copy into open on
your screen.

2 Point to the beginning of the text you want to copy. 

3 Press and hold down the mouse button.

4 Drag the pointer across the text you want to copy and release the mouse button at the
end of the selection. 

While the mouse button is held down, the text to be copied is highlighted.

5 Move the mouse pointer to the window in which you want the copied text to be inserted. 

6 Press the middle mouse button (or the Left Arrow key, if you are using a one-button mouse).

The copied text is inserted at the cursor's position.
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The aixterm menus

Usually, the aixterm menus are divided into two sections separated by a
horizontal line. The top portion contains various modes that can be toggled on
or off. A check mark is displayed next to a mode that is currently active.
Choose one of these modes to reverse its state. 

The bottom portion of the menu contains the command entries; choose one of
these to perform the action indicated.

The aixterm Options menu

To display the aixterm Options menu: 

1 With the mouse pointer anywhere inside the window, press and hold down the Control
key and the mouse button. 

2 When the aixterm Options menu appears, release the Control key.

3 While still holding down the mouse button, drag the pointer to the item you want to set or
reset, and then release the mouse button.

For instructions on using this menu, consult the article “Basic aixterm Tasks”
in InfoExplorer. InfoExplorer is described in Chapter 5.

The aixterm Modes menu

To display the aixterm Modes menu: 

1 With the mouse pointer anywhere inside the window, press and hold down the Control
key and the right mouse button (or the Right Arrow key, if you are using a one-button
mouse).

2 When the aixterm Modes menu appears, release the Control key.

3 While still holding down the right mouse button (or the Right Arrow key, if you are using
a one-button mouse), drag the pointer to the item you want to set or reset, and then
release the mouse button (or arrow key). 

For instructions on using this menu, consult the article “Basic aixterm Tasks”
in InfoExplorer. InfoExplorer is described in Chapter 5.
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Using the Common Desktop Environment

Help volumes, InfoExplorer information, and IBM’s hard copy manuals may
refer to the Common Desktop Environment (CDE) as AIXwindows Desktop,
Common Desktop Environment desktop, the CDE desktop, CDE, or simply, the
desktop. From this point on, this guide uses the term CDE. 

CDE allows you to access networked devices and tools without having to use
the command line. You can exchange data across applications simply by using
your mouse to drag and drop objects.

For more information on CDE, consult InfoExplorer (described in Chapter 5)
or Common Desktop Environment 1.0 User’s Guide (CDE Documentation
Group, Addison-Wesley Publishing Company, 1995).

Starting CDE from the command line

If you log in from the login window in graphic mode (described in the section
“Logging In,” Chapter 3), CDE starts automatically. If CDE is not set to start
automatically on your system, use the following command to start CDE from
the command-line interface: 

xinit /usr/dt/bin/dtsession

Setting up your system so that CDE starts automatically

You can use any one of three ways to configure your system so that CDE starts
automatically: 

m from the command line

m with the System Management Interface Tool (SMIT)

m with SMIT fastpath

This section tells you how to configure CDE autostart from the command line.
For information on configuring CDE autostart with SMIT or with SMIT
fastpath, use InfoExplorer, described in Chapter 5, to locate the article
“Starting and Stopping the AIX Common Desktop Environment.”
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To configure CDE autostart from the command-line interface:

1 Enter the following command:

/usr/dt/bin/dtconfig -e

2 Reboot the machine.

To disable CDE autostart:

1 Enter the following command:

/usr/dt/bin/dtconfig -d

2 Reboot the machine. 

Elements of CDE

The CDE front panel appears. 

The following paragraphs describe the icons displayed along the bottom of the
desktop.

Calendar

Click the Calendar icon to display a calendar application.

File Manager

Click the File Manager icon to display the File Manager. Use the File Manager
to handle desktop objects (such as files, directories, and application icons)
which you can manipulate without having to remember commands.

Using the Common Desktop Environment 49



Text Editor

Click the Text Editor icon to open a Text Editor window. Click the Help button
in the Text Editor window for information on using Text Editor.

Personal Applic ations menu

Click the arrow above the Text Editor icon to open the Personal Applications
menu, which contains the following items:

m Install Icon. Adds applications to the front panel. For assistance, click
Install Icon with the right mouse button and select Help.

m Text Editor. Opens a Text Editor window.

m Terminal. Opens a new terminal window.

m Icon Editor. Opens an Icon Editor dialog box. For assistance, click the Help
button in the Icon Editor dialog box.

Mail Applic ation

Click the Mail Application icon to display an application for sending and
receiving mail.

S c reen lo c k

Click the lock icon to lock the screen and display a dialog box that asks for the
user’s password to unlock the screen.

Wor ks pace switch button

Click the numbered buttons to switch between four different screens with
different applications running in each.
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Exit

Click Exit to begin the logout process.

Printers

Click the arrow above the Printers icon to display the Personal Printers menu,
which contains the following items:

m Install Icon

m Default Printer

St yle Manager

Click the Style Manager icon to display a dialog box that allows you to
customize the visual appearance or the behavior of your desktop.

A p plic ation Manager

Click the Application Manager icon to display the Application Manager,
which contains a variety of action icons that allow you to start applications.
Click the Application Manager Help button for more information.

Help Manager

Click the Help Manager icon to display a window that introduces you to
desktop help. Click the arrow over the Help Manager icon to display the Help
menu. For a description of the menu items, see “Using the Help Menu” later in
this chapter. 

Opening a terminal window on CDE

The default terminal emulator on CDE is the dtterm window, which is
discussed in the following sections. 
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O p ening a dtterm wind ow on CDE

To open a dtterm terminal window on CDE when no terminal windows are
currently open:

1 Click the arrow just above the Text Editor icon at the bottom of the screen.

The Personal Applications pop-up menu appears.

2 Choose Terminal from the pop-up menu.

A dtterm window appears.

If a dtterm window is already displayed, you can use the steps listed above to
open a new dtterm window, or you can do the following:

m Choose New from the Window menu of an existing window.

The dtterm menus are described in the next section, “Using the dtterm
Window” later in this chapter.

O p ening an aixterm wind ow on CDE

To open an aixterm window on CDE, do the following:

m In a dtterm window, enter

a i x t e r m &
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Using the dtterm window

The dtterm window operates much like the aixterm window that is described
earlier in this chapter. However, the aixterm menus do not operate in dtterm.
Instead, dtterm has a menu bar available that allows you to open a Window
menu, an Edit menu, an Options menu, and a Help menu. If the menu bar is
not displayed, you can display it by choosing Toggle Menu Bar from the
Window Manager menu (see the next section, “The dtterm Window Manager
Menu”) or by pressing the right mouse button (or the Right Arrow key, if you
are using a one-button mouse). 

Like other terminal windows, the dtterm window has a Window Manager
menu, which you display by pressing the Window Manager button at the
upper-left corner of the dtterm window. The illustration shows the Window
Manager button and the menu bar.

The dtterm Wind ow Manager menu

The dtterm Window Manager menu offers the following options: 

m Restore. Restores a maximized screen to its original size. See “Maximize”
later in this list. 

m Move. Allows you to move the window by repositioning the mouse pointer.
End the move by clicking the mouse button. 

m Size. Allows you to resize the window by moving the pointer to the border
you wish to change, then moving the border to its new position. End the
resizing by clicking the mouse button. 

m Minimize. Turns the window into an icon. 

m Maximize. Expands the window to occupy the full screen. Restore it to its
original size by choosing Restore from this menu. 

m Lower. Sends a window to the back or bottom of the window stack, the
position closest to the root window. The window remains active until
another window is made active. 
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m Occupy Workspace. Displays a menu that allows you to display the window
in a workspace other than the one it currently occupies. You can also choose
to replicate the window in all workspaces. See “Workspace Switch Button”
under “Elements of CDE” earlier in this chapter. 

m Occupy All Workspaces. Replicates the window in all workspaces. See
“ Wo rkspace Switch Button” under “Elements of CDE” earlier in this ch ap t e r.

m Unoccupy Workspace. Removes the window from the current workspace if
it occupies more than one workspace.

m Close. Closes the window. Applications running in the window are stopped. 

m Toggle Menu Bar. Removes or redisplays the menu bar. 

The dtterm Wind ow menu

The Window menu contains two items: 

m New. Opens a new dtterm window. 

m Close. Closes the current dtterm window.

The dtterm Edit menu

The Edit menu contains two items:

m Copy. Saves highlighted text to be copied. 

m Paste. Places copied text at the cursor position.

The dtterm Options menu

The Options menu contains the following items: 

m Menu Bar. Toggles the menu bar on and off. To toggle the menu bar back
on, choose Toggle Menu Bar from the Window Manager menu, or press the
right mouse button (or the Right Arrow key) and choose Menu Bar from the
Options menu. 

m Scroll Bar. Toggles the scroll bar on and off. 

m Global Options. Displays the Global Options dialog box. See 
“dtterm Global Options Dialog Box” next in this chapter. 

m Terminal Options. Displays the Terminal Options dialog box. See 
“dtterm Terminal Options Dialog Box” later in this chapter.
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m Window Size. Offers the choice of 80 X 24, 132 X 24, or Default. 

m Font Size. Offers several window-font sizes. 

m Reset. Offers a choice of hard or soft reset.

d tterm Global Options dialog box

Choose Global Options from the dtterm Options menu to display the Global
Options dialog box. 

The Global Options dialog box allows you to control the following:

m cursor style and blink rate

m window background color control (normal or inverse)

m smooth scrolling enabled or disabled

m bell type and margin warning

For additional information, click the Help button at the bottom left of the
dialog box.
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d tterm Ter minal Options dialog box

Choose Terminal Options from the dtterm Options menu to display the
Terminal Options dialog box. 

The Terminal Options dialog box allows you to control the following:

m Cursor Key Mode. Sets the mode to Normal mode (the default), to move the
cursor in the specified direction, or Application, to generate escape
sequences for an application to use.

m Keypad Mode. Sets the mode to Numeric mode (the default), to display the
numeral corresponding to the key pressed, or Application, to generate
escape sequences for an application to use.

m Newline Sequence. Allows you to choose between Return Only (the
default), which generates a carriage return, and Return/Line Feed, which
generates a line feed and a carriage return.
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m User Function Keys. Locks or unlocks the function keys.

m 132 Column Switching. Disables (the default) or enables 132-column
switching. When 132-column switching is enabled, if an application
switches to 132 columns, the window automatically enlarges to 132
columns. If 132-column switching is disabled, nothing happens if the
application switches to 132 columns.

m End-of-line Wrapping. Enables (the default) or disables wrapping text to the
next line when the end of the line is reached.

m Reverse End-of-line Wrapping. Disables (the default) or enables wrapping a
backspace at the beginning of a line to the previous line.

The Workspace menu

To display the Workspace menu, hold down the right mouse button while the
mouse pointer is on the desktop background. By default, the menu contains the
following items: 

m Shuffle Up. Moves the rearmost window to the top of the stack of windows.

m S h u ffle Down. Moves the top window in the stack to the bottom of the stack .

m Minimize/Restore Front Panel. Turns the front panel into an icon or 
restores it.

m Refresh. Refreshes the screen.

m Restart Workspace Manager. Restarts CDE.

m Logout. Displays a Logout Confirmation dialog box, which allows you to
proceed with the logout or to cancel it.
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Using CDE Help

The first time you log in to CDE, a help window introducing the desktop is
displayed that provides quick access to helpful topics. 

m To display information about using desktop menus and controls and other
introductory topics, click the topic “Basic Desktop Skills.” 

m Click the topic “A Quick Tour of the Desktop” for an introductory review of
the types of applications available in the CDE environment.

m Click the topic “How to Get Help” for details about accessing and using
CDE Help.

Acc es sing CDE topics

You have a number of ways to access CDE Help topics:

m Help key. The quickest and easiest way to get help is to press F1, 
usually known as the Help key. When you press F1, the application you 
are using responds by displaying the help topic most closely related to 
your current activity.

m Help Manager. To access the extensive CDE Help volumes:

1 Click the Help Manager icon located on the CDE front panel. 

When you click the Help Manager icon, the Help Manager dialog box appears,
which contains a hypertext-linked list of all the help volumes that support 
the desktop. 

2 In the Help Manager dialog box, click “Common Desktop Environment (CDE)” to display
the list of help volumes that have been installed on your desktop. 

Browse the list of titles. 

3 To open a volume, click its title. 
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Using the Help menu

To view the Help menu and its available items, click the arrow above the Help
Manager icon.

The Help menu contains the following items:

m Install Icon. Adds ap p l i c ations to the front panel. For assistance, cl i ck Install
Icon with the right mouse button (or the Right Arrow key) and select Help.

m Help Manager. Displays the Help Browser help volume, which gives you
access to the installed desktop help volumes on the system.

m Desktop Introduction. Displays the help volume titled “Introducing the CDE
Desktop,” which contains topics covering basic desktop concepts and skills.
This help volume appears automatically the first time a user logs in to CDE.

m Front Panel Help. Displays the help volume for the front panel; it contains
information on how to use and customize the front panel.

m On Item Help. Changes the pointer to a question mark that you can drag and
drop on desktop objects for specific information on those objects. 

Special Circumstances 

If you need to start applications on a workstation other than your own, and that
workstation is also running the CDE desktop, you may need to do some
configuring on both workstations.

Also, if your CDE desktop has one of the following special configurations,
you may need to change certain Login Manager files before starting CDE:

m Your system console is an ASCII terminal.

m Your system is an X terminal or a host for X terminals.
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This chapter presents an overview of the use of InfoExplorer, IBM’s
information retrieval system. 

This chapter covers the following topics:

m using InfoExplorer’s graphical interface

m using InfoExplorer’s ASCII interface

m navigating through InfoExplorer

m searching by word and phrase

m customizing InfoExplorer
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Introduction to InfoExplorer

The Hypertext Information Base Library contains information on how to use,
manage, and program the AIX operating system and other programming
language software. InfoExplorer allows you to find all information in the
Hypertext Information Base Library, and thus serves as a complete on-screen
information source.

Starting InfoExplorer

You can view InfoExplorer in the InfoExplorer graphical interface or the
InfoExplorer ASCII interface. 

Starting InfoExplorer in graphics mode

There are two ways to start InfoExplorer in graphics mode. If CDE is
displayed, you may do the following:

1 Double-click the Application Manager icon.

2 In the Application Manager window, double-click the Information icon.
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3 In the Application Manager - Information window, double-click the InfoExplorer icon.

If you are working in the command-line interface, do the following:

m Enter the command

info -g 

You may start InfoExplorer from a terminal window in AIXwindows or CDE
as follows:

m Enter the i n f o command. 

By default, two windows appear: 

m A navigation window containing, by default, the article  “Topic & Task
Index.” This default can be changed. See “Customizing the InfoExplorer
Graphical Interface” later in this chapter. 

m A reading window that contains the article “Welcome to the InfoExplorer
Window Interface,” which shows you how to perform basic window
operations. 

The navigation window has two rows of buttons at the bottom of the window
that o ffer a va riety of options for nav i gating through the info rm ation dat ab a s e.

For further information on InfoExplorer in graphics mode, see “Using the
InfoExplorer Graphical Interface,” next in this chapter. For further information
on types of windows used by InfoExplorer, see “InfoExplorer Windows” later
in this chapter.

For information on starting and using InfoExplorer in ASCII mode, see “Using
the InfoExplorer ASCII Interface” later in this chapter.

For information on the command options that you can use with the i n f o
command, see “The i n f o Command Options” later in this chapter.
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Using the InfoExplorer graphical interface

The following paragraphs describe the use of the graphical interface. 

Using InfoExplorer to learn InfoExplorer (graphical interface)

This section offers a quick procedure for displaying Chapter 7, “Accessing
Information With InfoExplorer,” of IBM’s AIX Version 4.1 Getting Started. If
you are planning to use the InfoExplorer ASCII interface, see “Using
InfoExplorer to Learn InfoExplorer (ASCII Interface)” later in this chapter. 

1 Click the List of Books button at the bottom of the navigation window.

The List of Books appears. 

2 In the list headed “Base Operating System Books,” click AIX Version 4.1 Getting Started.

3 Scroll down to Chapter 7.

4 Click the title of the section you wish to consult.

The text is displayed.

5 If you wish to print the article, choose Print from the Info menu (in the menu bar of the
reading window).

Highlighting conventions in InfoExplorer articles

The Hypertext Information Base Library uses the following font and
highlighting conventions: 

m Bold identifies commands, keywords, files, directories, and other items
named by the system.

m Italics identifies parameters for which you supply the names or values.

m C o u r i e r i d e n t i fies examples of specific data values, displayed text, port i o n s
of program code, messages from the system, or information you enter.
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InfoExplorer windows

InfoExplorer uses two basic types of windows: navigation windows and
reading windows.

Navigation wind ows

N av i gation windows help you nav i gate to the art i cles containing the info rm at i o n
you want. Navigation windows contain lists of topics with hypertext links. The
hypertext links are enclosed in boxes. They allow you to display articles on the
specific topic. Only one navigation window can be displayed at a time. The
contents of the navigation window are replaced each time you display another
navigation window. 

The buttons at the bottom of the Navigation window are described briefly in
the following table. 
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Button Material displayed

Topic & Task Index A list of tasks and topics grouped by subject area

List of Commands Information on commands listed alphabetically and by functional
categories

List of Books A list of AIX documents available with InfoExplorer 

Programming Reference Programming reference information arranged under major functional
categories that are listed alphabetically

History A list of all InfoExplorer locations accessed since starting
InfoExplorer or clearing the History list

List of Bookmarks A list of bookmarks used to mark places in the InfoExplorer database
for future reference

List of Notes Notes you have made about the information you have accessed

Path The path of your information search through InfoExplorer

Search A simple or a compound search window for entering words and 
phrases and criteria for your search through the database

Reading wind ows

Reading windows contain conceptual, procedural, or reference information on
a topic. They explain how to perform a task, or they document commands,
calls, subroutines, files, or file formats. You can display more than one reading
window at a time (with the Hold button), or you can have the contents of the
window replaced each time you select more information. 

You can click the following buttons that appear at the bottom of a reading
window in order to perform the actions indicated:

m Make Note. Creates a note and places a note icon in the text. Click the Up
Arrow button to jump to the previous note; click the Down Arrow button to
jump to the next note.

m M a ke Bookmark. Cre ates a bookmark in the text. Click the Up Arrow bu t t o n
to jump to the previous bookmark; click the Down Arrow button to jump to
the next bookmark (if you have previously loaded a list of bookmarks).
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m Path. Displays your path list. You can jump to any article in your path list,
or you can clear or modify the path list. Click the Up Arrow button to jump
to the previous item; click the Down Arrow button to jump to the next item
on your path list. 

m Search. Searches the InfoExplorer or other databases for specific terms 
or phrases. 

At the top of the window, there are three buttons that you can click to activate
reading-window functions:

m Hide Links. Alters the text so no links show. To hide links, click the Hide
Links button. To show all links, release the Hide Link button by clicking 
it again.

m H o l d. Opens an art i cle in a new window without replacing the ori ginal art i cl e.

m Close. Closes the reading window. 
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Using InfoExplorer graphical interface Help

From an InfoExplorer window, you can view help information about the
functions and options available for the current window, or you can search
through a list of topics for the appropriate help information.

Dis playing Help for a specific wind ow

The Help menu in each window contains an On Window item, which displays
an article describing the function, menus, and buttons that are available in the
current window.

To display help for a window:

1 Click Help in the menu bar to display the Help menu.

2 Choose On Window.

A help article opens in a new reading window.

Getting Help from the List of Helps

The Help menu in each InfoExplorer window contains a List of Helps item,
which displays a list of InfoExplorer help topics. The help articles display the
information and procedures for a wide range of tasks.

To use the List of Helps:

1 Click Help in the menu bar to display the Help menu.

2 Choose List of Helps.

3 Click the desired help topic.
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Searching for information 

InfoExplorer allows you to look for information by word or phrase. This type
of search looks through the entire text of the hypertext information base. For
example, you can search for information even if you do not know a task or
command name under which the information is stored. 

You can perform a simple search or a compound search. The simple search
allows you to search using a word or string of words (in exact order) in text,
article titles, or both. The compound search allows you to search using a word,
set of words, or several sets of words. Moreover, the compound search allows
you to specify the search with the following options:

m And, Or, and But Not operators

m proximity options

m search categories

m precedence

Sp e c ifying the databases to searc h

There are two ways to specify the information databases to be searched:

m Select a temporary information database in the Compound Search window.
This selection applies to both simple and compound searches and stays in
effect for the current session of InfoExplorer or until you change the
selection during the session.

m Select a default information database by choosing Defaults from the
Options menu (see “Customizing the InfoExplorer Graphical Interface”
later in this chapter). This default information database applies to both
simple and compound searches and stays in effect for future sessions of
InfoExplorer. Temporary information database selections made from the
Compound Search dialog box can override the default selection during 
an InfoExplorer session, but the default selection returns when you restart
InfoExplorer.
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The simple searc h

You can perform a simple search as follows: 

1 Click the Search button at the bottom of the navigation window.

The Simple Search dialog box appears.

2 Type the phrase for which you are searching in the Search For field and press Return.

A list of articles on the simple search appears.

If you wish to print the article, choose Print from the “info” menu.

For an on-screen tutorial about perfo rming a simple search, fo l l ow the dire c t i o n s
in “Using InfoExplorer to Learn InfoExplorer (Graphical Interface),” earlier in
this chapter, to find the section “Searching for Information (InfoExplorer
Windows)” in Chapter 7 of IBM’s AIX Version 4.1 Getting Started.

The comp ound searc h

If the Simple Search dialog box appears when you click the Search button in
the navigation window, click the Compound Search button at the bottom right
of the Simple Search dialog box. The Compound Search dialog box appears. 
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This dialog box allows you to enter four text strings. You can specify 
the following:

m The buttons along the left of the last three text boxes allow you to choose
the And, Or, or But Not operators. 

m You may specify whether the strings should appear in the same article 
or paragraph. 

m You may specify how far apart they must be within a paragraph. 

m You may choose the databases, categories, and fields in which they 
must appear.

For more information about compound searches, do a simple search to find the
InfoExplorer articles “How to Perform a Compound Search (InfoExplorer
Windows)” and “The Compound Search Window.” The simple search is
described in this chapter in the previous section. 
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Printing from the InfoExplorer graphical interface

You can print the following information from the InfoExplorer 
graphical interface: 

m articles from a reading window

m all articles referred to by a navigation window

m artwork displayed in a graphic window

m public and private notes

For detailed information on printing, follow the directions in “Using
InfoExplorer to Learn InfoExplorer (Graphical Interface),” earlier in this
chapter, to find the section “Printing Information (InfoExplorer Windows)” 
in Chapter 7 of IBM’s AIX Version 4.1 Getting Started.

Keys and keystroke sequences for the InfoExplorer 
graphical interface

In the InfoExplorer graphical interface, you can use special keys and key
sequences to move within a window, choose items from a menu, access
additional windows, and start processes. 

For detailed information, follow the directions in “Using InfoExplorer to
Learn InfoExplorer (Graphical Interface),” earlier in this chapter, to find the
section “Using Special Keys and Key Sequences (InfoExplorer Windows)” in
Chapter 7 of IBM’s AIX Version 4.1 Getting Started.

Stopping InfoExplorer

You can stop the InfoExplorer program from any open InfoExplorer window. 

To exit the InfoExplorer program and save all bookmarks and notes:

m Choose Quit from the “info” menu in any InfoExplorer window. 

All open windows are closed and the program is exited.

To exit the InfoExplorer program without saving all bookmarks and notes:

m Choose Close from the navigation window menu located to the left of the title bar.

All open windows are closed and the program is exited.
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Customizing the InfoExplorer graphical interface

The Options menu in the navigation window allows you to reset 
InfoExplorer defaults. 

1 Choose Defaults from the Options menu (in the navigation window’s menu bar).

The Defaults Editor dialog box appears.

2 To change the default search databases, click the button below the Default Search
Databases option; to change the default navigation article, click the button below the
Default Navigation Article option.

3 Click the appropriate item in the list that appears. 

4 Click the Save button. 
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Using the InfoExplorer ASCII interface

This section introduces the InfoExplorer program ASCII interface. Since
InfoExplorer information is hypertext, you view the information on your
computer screen and select links to move from one article to another. Thus you
can choose your own path through the hypertext documentation. 

Starting InfoExplorer in ASCII mode

To start InfoExplorer in ASCII mode: 

m Enter the  command

info -a

A navigation screen appears that is, by default, the Topic & Task Index screen.
To change this default, see “Customizing the InfoExplorer ASCII Interface”
later in this chapter. The navigation screen displays lists of topics that contain
hypertext links to pertinent articles. The articles are displayed in a reading
screen. For more information on navigation screens and reading screens, see
“InfoExplorer ASCII Screens” later in this chapter.

Using InfoExplorer to learn InfoExplorer (ASCII interface)

This section offers a quick procedure for displaying Chapter 7, “Accessing
Information With InfoExplorer,” of IBM’s AIX Version 4.1 Getting Started.

1 Press Control-O to activate the menu bar.

2 Use the Left and RIght Arrow keys (or press D) to highlight Display in the menu bar, then
press Return.

3 Use the Down Arrow key to highlight List of Books in the Display menu.

4 Use the Tab key to highlight AIX 4.1 Getting Started, then press Return.

5 Use the Tab key to highlight the section you wish to consult.

6 Press Return to display the information.
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To print the article:

1 Press Control-O to activate the menu bar.

2 Press I to highlight “info” and press Return to display the menu.

3 Use the Down Arrow key to highlight Print Article, then press Return.

InfoExplorer ASCII screens

In the InfoExplorer ASCII interface, different screens contain different types
of information. For example, you use some screens specifically for moving
through the information database. These screens, which include the Topic &
Task Index and the Books, are navigation screens. The InfoExplorer program
d i s p l ays one nav i gation screen at a time. The contents of this screen are rep l a c e d
each time you select a function that displays its information in this location.

The screen that contains the text you want to read is called the reading screen.
When you do an information search, the navigation screen becomes the
reading screen. Reading screens provide conceptual, procedural, or reference
information. They display articles that teach you about a topic, explain how to
do something, or provide you with information about commands, calls,
subroutines, files, or file formats.
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The reading sc reen

When you start the InfoExplorer ASCII interface for the first time, the first
screen that appears is the reading screen, containing the document “Welcome
to the InfoExplorer ASCII Interface.” The reading screen contains procedural,
conceptual, and reference information. The first line of the screen displays the
menu options, and the second line displays a title bar. The phrase “info
Document” appears at the right end of the title bar. 

Only one reading screen is available at a time. Each time you select a link to
another article, the contents of the article you select replace the contents of the
original article. 
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The navigation sc reen

The navigation screen is the starting point for finding documentation about the
operating system and other programs available on your system. Information is
organized by topic and task, by book, or alphabetically by commands or
programming reference items. 

The first line of the screen contains the menu bar; the second line displays a
title bar that displays the title of the screen. In the figure below, the second 
line informs you that the title is Topic & Task Index and that this is a
navigation screen.

Note: The navigation information in this section applies to the InfoExplorer
program that is shipped with your operating system. The navigation
information may or may not apply to other libraries.

While you are viewing the InfoExplorer program through the ASCII interface,
only one navigation screen is available at a time. Each time you select a link to
another navigation article, the contents of the article you select replace the
contents of the original article. For information on selecting links, see
“Selecting an ASCII Hypertext Link” later in this chapter.
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Moving between the screens

To return to the navigation screen from the reading screen (or to go back to the
reading screen from the navigation screen), press Control-W. 

Selecting an ASCII hypertext link

Items that are underscored in navigation screens or reading screens are
hypertext links; the currently selected link is highlighted in reverse video. 

To follow a link to more information:

1 Press the Tab key (or Control-F) to move from one link to the next. 
Press Control-B to move back to the previous link.

2 Press the Return key to display the linked information.

Getting Help

You can display the Help menu as follows: 

1 Press Control-O to activate the menu bar at the top of the screen.

2 Use the Left and Right Arrow keys (or press H) to highlight the menu title Help.

3 Press Return. 

You can then choose between the following items:

m This Window. Displays specific help information for the screen you are
viewing, including the following:
—links to articles that describe the screen
—functions available from that screen
—a list of menus available in the screen
—links to descriptions of the menu items

You can select links to display information that you want to read. To 
return to the help information screen after selecting a link, use the Path or
History menu in the menu bar. See “Returning to a Previous Location” 
later in this chapter.

m List of Helps. Displays a list of hypertext links to articles that describe key
aspects of the InfoExplorer program and documentation, along with links to
the individual help screens. 
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Scrolling information in ASCII screens

You can move forward or backward through text displayed in either the
navigation screen or the reading screen by using the following keys and key
sequences. 

Move Keystroke

Previous page Page Up key or Control-P

Next page Page Down key or Control-N

Cursor up one line Up Arrow 

Cursor down one line Down Arrow

Choosing an ASCII menu item

Each InfoExplorer screen contains a menu bar across the top of the screen. To
choose a menu item, do the following: 

1 Press Control-O to activate the menu bar.

2 Use the Left and Right Arrow keys (or type the initial letter of the menu title) to highlight
the title of the menu you want to display, then press Return. Instead, you may type the
underlined character in the menu title.

The menu is displayed as a pull-down panel with several items.

3 Use the Up Arrow and Down Arrow keys to highlight a menu item (or type the underlined
character in the desired menu item); then press Return.

The item you choose is invoked, or another menu is displayed. 

To remove a menu without choosing an item, press Control-O. The cursor
returns to the screen.
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Returning to a previous location

During the InfoExplorer session, the InfoExplorer program keeps two different
records of where you have previously been: the History List and the Path List.
These lists enable you to re t u rn to previous locations in the info rm ation dat ab a s e.

History List

The History List records every location that you have displayed in the
information database during the current InfoExplorer session. To view the
History List, do the following:

1 Activate the menu bar by pressing Control-O (if it is not already activated).

2 Use the Left Arrow and Right Arrow keys (or press the period key) to highlight .History,
then press Return.

The History menu is displayed.

3 Use the Up Arrow and Down Arrow keys to highlight the List All item, then press Return.

4 Use the Left Arrow and Right Arrow keys to highlight the location to which you wish 
to return.

5 Press Control-O to activate the menu bar.

6 Goto in the menu bar should be highlighted. If it isn’t, highlight it, then press Return.

Path List

The Path List keeps track of your current navigation route starting with a
primary navigation screen (Topic & Task Index, Books, Commands, or
Programming Reference). Every time you return to a primary navigation
screen, your previous path list is overwritten.

The Path menu contains three options: 

m Show List. Displays the path list.

m Previous. Jumps to the previous location without displaying the path list.

m Next. Jumps to the next location without displaying the path list.
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To return to a previous location in the InfoExplorer program: 

1 Activate the menu bar by pressing Control-O.

2 Use the Left Arrow and Right Arrow keys (or type P), then press Return to display the
Path menu.

3 Use the Up Arrow and Down Arrow keys (or type S), then press Return, to display the
Path List. 

A pop-up box displays a list of locations in the path. If you are in a primary
navigation screen, you receive a message stating that the Path List is empty.

4 Use the Up Arrow and Down Arrow keys to highlight the location to which you want 
to return.

5 Press Control-O to activate the menu bar.

6 Highlight Goto in the menu bar, then press Return.

The text appears in the reading screen.

Finding information via the primary navigation routes

To display the primary navigation routes in the navigation screen: 

1 Press Control-O to activate the menu bar.

2 Use the Left Arrow and Right Arrow keys (or press D) to highlight Display.

3 Press Return to display the menu, which offers the following choices:

m Task (the Topic & Task Index). Displays information by task. This is the
default navigation article.

m Commands. Displays an alphabetical list of available commands.

m Books. Displays a list of art i cles arra n ged as though in hard - c o py book fo rm .

m Programming Reference. Displays lists of programming functions in
alphabetical order by functional categories.
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Searching by word and phrase

If you do not know what a task or command is, or in which book the
information resides, use the search facility to search the InfoExplorer
information database.

Two types of searches are available in InfoExplorer: the simple search and the
compound search. 

The simple search allows you to use a word or string of characters (in exact
order) to search through text, article titles, or both. In the ASCII version of
InfoExplorer, the Article Title item on the Search menu lets you perform a
simple search of article titles. 

The compound search allows you to search using a word, a set of words, 
or several sets of words. You can further specify the search with the 
following options: 

m And, Or, and But Not operators

m proximity options

m search categories

You can also specify the information databases to be searched for both simple
and compound searches. Th e re are two ways to specify an info rm ation dat ab a s e :

m You can select a temporary information database in the Compound Search
dialog box. This selection applies to both simple and compound searches
and stays in effect for the current session of InfoExplorer or until you
change the selection during the session.

m You can select an information database as a default by choosing Defaults
from the “info” menu and selecting DBselect. This default information
database applies to both simple and compound searches, and stays in effect
for future sessions of InfoExplorer. 

Temporary information database selections made in the Compound Search
dialog box can override the default selection during an InfoExplorer
session, but the default selection returns when you restart InfoExplorer.
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The simple searc h

You can perform a simple search as follows: 

1 Press Control-O to activate the menu bar.

2 Use the Left and Right Arrow keys (or press S) to highlight Search, then press Return.

3 Use the Up and Down Arrow keys to highlight Simple in the Search menu, then 
press Return.

The Simple Search dialog box appears.

4 Type the word or phrase you are searching for in the Find field, then press Return.

A list of articles appears.

For an on-screen tutorial about performing a simple search, follow the
directions in “Using InfoExplorer to Learn InfoExplorer (ASCII Interface),”
earlier in this chapter, to consult “Searching for Information (ASCII
Interface)” in Chapter 7 of AIX Version 4.1 Getting Started.
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The comp ound searc h

You can perform a compound search as follows: 

1 Press Control-O to activate the menu bar.

2 Use the Left Arrow and Right Arrow keys (or press S) to highlight Search, then 
press Return.

3 Use the Up Arrow and Down Arrow keys to highlight Compound, then press Return.

The dialog box for doing a compound search appears.

Press the Tab key to move from field to field; in the highlighted fields, press
the arrow keys to display the available choices.

The Find field allows you to specify three text strings and three operators
(And, Or, But Not) to relate those strings to one another in the order in which
they are displayed in the dialog box. For more information, see the
InfoExplorer article “Narrowing or Broadening a Compound Search.”

The Within field allows you to designate the proximity of the specified 
text strings (within the same article; within 10, 50, or 100 words of the 
same paragraph).

The Search field allows you to specify the kind of text searched (in the first
field) and where in the database to perform the search (in the second field,
following the word “in”).

4 Press Control-O to activate the menu bar.
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5 Choose Search to proceed with the search.

A search match list appears.

6 Use the Up Arrow and Down Arrow keys to highlight the appropriate item, then press
Return. To list all hits in all sources, press Control-O to activate the menu bar; then, with
Goto highlighted, press Return.

A list of sources and the number of hits in each source appears. 

7 Use the Up Arrow and Down Arrow keys to highlight the appropriate item, then 
press Return.

The appropriate information appears in a reading window.

For a more detailed description of the compound search, see the InfoExplorer
article “How to Perform a Compound Search (ASCII).”

Printing from the InfoExplorer ASCII interface

Follow the directions in “Using InfoExplorer to Learn InfoExplorer (ASCII
Interface),” earlier in this chapter, to consult “Printing Information (ASCII
Interface)” in Chapter 7 of AIX Version 4.1 Getting Started.
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Keystrokes used in the InfoExplorer ASCII interface

Different keys and key sequences are active depending on whether you are
working in a text area, a menu bar, or a pop-up screen. 

Keystrokes used in text areas

Keys Action

Control-W Toggles between the navigation screen and the reading screen

Control-F or Tab Moves to the next hypertext link

Control-B Moves to the previous hypertext link

Return or Enter Activates an operation

Control-L Refreshes the screen

Control-N or Page Down Scrolls vertically to the next page

Control-P or Page Up Scrolls vertically to the previous page

Left Arrow Moves the text cursor one character to the left

Right Arrow Moves the text cursor one character to the right

Up Arrow Moves the text cursor up one line

Down Arrow Moves the text cursor down one line

< Moves the text cursor 20 characters to the left

> Moves the text cursor 20 characters to the right

Note: The Left Arrow and Right Arrow keys do not function for the
InfoExplorer program on WYSE terminals.

Keystrokes used in menu bars

Keys Action

Control-O Toggles to make the menu bar active or inactive. 

Esc-Esc or Control-O Closes a pull-down menu and places the cursor in the text area.

Tab Highlights the next menu in the menu bar. In pop-up screen menu
bars, moves the cursor from the menu bar into the text area if no 
pull-down menus are currently highlighted.

Left Arrow Highlights the previous option. If a pull-down menu is displayed, the
previous menu title is highlighted and its pull-down menu is displayed.
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Keystrokes used in menu bars (continued)

Keys Action

Right Arrow Highlights the next menu. If a pull-down menu is displayed, the next
menu title is highlighted and its pull-down menu is displayed.

Up Arrow Displays the pull-down menu for the highlighted menu title or highlights
the previous item in a pull-down menu.

Down Arrow Displays the pull-down menu for the highlighted menu title or highlights
the next item in a pull-down menu.

Return or Enter Activates the operation of the highlighted menu item.

In some cases, the menu bar within a pop-up screen contains options that start
or stop a process. The following keys can also be used to move within a 
pop-up screen or to cycle through options in the screen.

Keys Action

Tab Moves to the next field

Left Arrow Moves to the previous option in a group of options

Right Arrow Moves to the next option in a group of options

Spacebar Cycles through the options in a group of options

Up Arrow Highlights the previous item in a list

Down Arrow Highlights the next item in a list

Return or Enter Activates the operation of the highlighted item, or ends text entry and 
advances to the next field

Stopping the InfoExplorer ASCII program

You can leave the InfoExplorer program from either the navigation screen or
the reading screen. 

1 Activate the menu bar by pressing the Control-O key sequence.

2 Use the Left Arrow and Right Arrow keys (or press E) to highlight Exit, then press Return.

The Exit menu appears.

3 Choose the Confirm option by pressing Return. 

The operating-system command prompt appears and the InfoExplorer 
program stops.
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Customizing the InfoExplorer ASCII interface

You can change the defaults for the following items of the InfoExplorer 
ASCII interface: 

m navigation window article

m history, notes, and bookmark files

m printers

To change the defaults:

1 In the navigation window, activate the menu bar by pressing Control-O.

2 Use the Left Arrow and Right Arrow keys (or press i) to highlight “info,” then press Return.

3 Use the Up Arrow and Down Arrow keys to highlight Defaults, then press Return.

Use the dialog box that is displayed to change the default navigation article,
move the cursor into the Navigation Article field, and press the arrow keys to
display the available options for the default navigation article.

To edit the printer fields, move the cursor into the appropriate Printer field and
edit the existing text.

To set the default Bookmark, History, and Notes fields, choose from the file
lists in the Bookmarks, History, and Notes items in the menu bar of the
Defaults screen. For further information, see the InfoExplorer article “How to
Set Defaults.”

4 From the menu bar in the Defaults screen, choose Save to save the changes; choose
Reset to delete the changes.
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The i n f o command options

You can use the i n f o command with the items listed in the table. 

Option Function

- a Starts InfoExplorer ASCII version.

- d i s p l a y host:number Specifies the display host.

-f isofonts Specifies for text to be displayed in ISO fonts.

- g Forces the window version of InfoExplorer to run on the default 
display or the display specified by the - d i s p l a y option.

- h string Specifies a term that is used to search for a command article or 
content list for a specified topic or task.

- h e l p Displays the usage message.

- h l c color Specifies the color for hypertext links.

- i c o n i c Starts InfoExplorer with the navigation window icon on the 
desktop. After the icon is opened, all application windows 
open normally.

- l libname Specifies which database library InfoExplorer opens.

- m s h N Specifies the maximum number for search hits.

-n [ti | bl | cl | pr | [1–8] ]
Specifies the alphabetic abbreviation or the numeric value 
identifying which primary navigation article is displayed.

- q Starts InfoExplorer quickly without displaying the copyright notice 
and the InfoExplorer “Welcome” article.

- s term Specifies a term or phrase that is immediately used in a 
simple search.

- s h c color Specifies the color for search hits.

- t string Specifies a term or phrase that is immediately used in a 
title search.

- t a g s Sets the debug environment switch enabling the inclusion of the 
Tags menu in the Preferences window menu bar.

- t x c color Specifies the color for article text. 
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This chapter describes the following tools that provide special interfaces for
handling system administration tasks:

m Visual System Management (VSM)

m System Management Interface Tool (SMIT)

6 Using System Administration Tools



Visual System Management

Visual System Management (VSM) is a graphical interface that enables you to
perform installation and system management tasks through direct
manipulation of icons. For example, you can delete a user by dragging the
User icon to the Trash Can icon. In addition to performing basic tasks, you can
create new objects from system-defined or user-defined templates; sort, filter,
and find objects; and display the objects in a variety of views. 

Starting VSM applications

You can start VSM applications from the command line (see “Starting VSM
from the Command Line” later in this chapter) or from CDE.  

Star ting VSM from CDE

Start VSM from CDE as follows:

1 From the front panel, click the Application Manager icon.

The Application Manager window appears.
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2 Double-click the System_Admin icon.

This displays the Application_Manager–System_Admin window.

3 Double-click the desired application icon.
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Star ting VSM from the command line

You can start the following VSM applications from the command line of a
terminal window with the commands listed.

Application name Command

Device Manager x d e v i c e m

Easy Install xinstallm -ez

Install Manager x i n s t a l l m

Maintain Software x m a i n t m

Print Manager x p r i n t m

Storage Manager x l v m

Users & Groups Manager x u s e r m

The VSM interface 

The features common to many VSM application windows are described in
this section. 

As an example, the Storage Manager window is illustrated.

Most VSM applications contain a work area that contains panes and wells, an
area that contains actions, and an information area. For more information
about how to work in a specific VSM application, read the help text in the
information area, or click the Help button to start the Help System.

Work area panes and wells

The work area is organized into panes containing icons that represent specific
related functions or objects. You can double-click some of these icons that
contain related objects to display a well (or wells). The well displays the
related objects. Double-clicking an object that cannot be expanded brings up a
notebook (dialog box) displaying the object’s attributes. For information on
working with objects, refer to the help in the information area. 
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Ac tions — drag ging and drop ping

The icons in the area labeled “Actions” represent various actions that you can
perform on the objects in the panes and wells of the work area. Perform these
actions by moving the mouse pointer to the action, pressing the middle mouse
button (or the Left Arrow key), and dragging the action icon to the appropriate
object on which you wish to perform the action. This is referred to as dragging
and dropping. 

VSM dialog boxes

Dialog boxes appear if the system requires additional information for
completing a task. For more information about dialog boxes, select the Help
button in a dialog box. For information about the fields and buttons in a dialog
box, click the question mark (?) button at the bottom of the dialog box. 

Infor mation area

The information area displays a brief description of the object or area at which
the mouse pointer is located. See the next section, “Getting Help in VSM.” 
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Getting help in VSM

All information about the application and how to use it is available on screen.
Use the following methods to access help in the interface.  

Infor mation area

The information area, which is at the bottom of the dialog box, provides
context-sensitive help based on the position of the cursor. The description
provided is often accompanied by an explanation of the task you can perform. 

Drag ging and drop ping the Item Help (?) ac tion icon

Use the middle mouse button (or the Left Arrow key) to drag and drop the
Item Help (?) action icon on a target to open a Help System window that takes
you directly to the help for that target. Use the Item Help (?) action icon to
learn more about a specific object or area. For more detailed information about
the concepts discussed in the help screens, see the AIX Version 4.1 System
Management Guide: Operating System and Devices.

? and Help buttons in a dialog box wind ow

The question mark (?) button in a dialog box opens a help window that
provides context-sensitive help for the highlighted field in the dialog box. The
Help button opens the Help System window displaying the help topic for
dialog boxes.

Help button in a mes sage wind ow

The Help button in a message window provides more information about 
the message. 
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VSM applications

The following sections describe how to use the available VSM applications.
Start these applications by double-clicking their icons in the
Application_Manager–System_Admin window or by entering a command, if
available, at the command line. 

Device Manager

Double-click the Device Manager icon (or enter x d e v i c e m at the command
line) to display the Device Manager dialog box. 

Device Manager displays system objects and dialog boxes that repesent the
contents of your system’s Device Configuration database. This enables you to
manage some devices not covered by SMIT, such as graphic adapters, graphic
display subsystems, ports, buses, expansion drawers, non-SCSI adapters,
standard adapters, and memory cards. The Show Tree View button (at the
bottom left of the dialog box) allows you to view how the devices are
interconnected. 

Device Manager does not include the following SMIT functions:

m trace devices

m printer subsystem management (including virtual printers)

m communications applications and services

m LFT devices: keyboard, displays, fonts, speakers

m Xstation configuration

Easy Install

Double-click the Easy Install icon (or enter xinstallm -ez at the command
line) to display the Easy Install dialog box, wh i ch allows you to install softwa re.
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Install Assistant

D o u bl e - cl i ck the Install Assistant icon to display the Install Assistant dialog box. 

This dialog box offers an interface for performing the following tasks:

m setting the date and time and the root password

m configuring network communications

m managing system storage, paging space, and the language environment

m creating user accounts

m defining printers

m importing existing volume groups

m installing software applications

m backing up the system

Install Manager

Double-click the Install Manager icon (or enter x i n s t a l l m at the command
line) to display the Install Manager dialog box. 

This dialog box allows you to perform the following tasks:

m installing and updating software products

m creating bundles

m defining installation settings

Maintain Sof tware

Double-click the Maintain Software icon (or enter x m a i n t m at the command
line) to display the Maintain Installed Software dialog box. 

This dialog box allows you to perform the following tasks:

m commit to a software update and automatically remove all previous versions

m reject an applied update, remove the updated files, and revert to a previous
version of the software

m verify the correctness of the installed software
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Print Manager

Double-click the Print Manager icon (or enter x p r i n t m at the command line)
to display the Print Manager dialog box. 

This dialog box enables you to perform basic SMIT tasks on printers and
queues and is designed to make creating queues much simpler. In addition, it
provides a graphical representation of queue and printer attachments as well as
print jobs waiting in the queue.

Print Manager does not include the following SMIT functions:

m starting a print job

m scheduling jobs

Storage Manager

Double-click the Storage Manager icon (or enter x l v m at the command line) to
display the Storage Manager dialog box. 

This dialog box enables you to manage physical volumes, volume groups,
logical volumes, and file systems through direct manipulation. In addition,
S t o rage Manager provides an easy way to view the contents of a logical vo l u m e.

Users & Groups Manager

Double-click the Users & Groups icon (or enter x u s e r m at the command line)
to display the Users & Groups Manager dialog box. 

This dialog box simplifies adding users by providing system-defined and user-
customized templates. Simple drag-and-drop actions enable you to set user
passwords, change a user's language, and specify whether or not a user can log
in to a system. 
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